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Otimizando o Windows2000 pelo registro

Dedico esta apostila a todos os administradores de redes W2K, que sonham um dia com um S.O. rapido, eficiente
e seguro. Livre de bug’s e problemas. Copyright by RHJ, Suporte Técnico em S.Os e redes

o Removendo Programas -> Abra o regedit e localize a chave: HKEY_LOCAL_MACHINE\
SOFTWARE\ MICROSOFT\ WINDOWS\ CURRENTVERSION\ UNINSTAL

. Setas no icones dos atalhos -> Abra o regedit e localize a chave
HKEY_CLASSES ROOT\LNKFILE,um clique sobre a chave LsShortCut, pressione a tecla delete.

o Removendo icones do Desktop, com 4 pastas existentes clique em uma delas, ao lado direito na parte de
dados contém sua descricao-> regedit; HKEY LOCAL _MACHINE\ SOFTWARE\ \MICROSOFT\
WINDOWS\ CURRENTVERSION\ EXPLORER\ DESKTOP\ NAMESPACE

. Menu Iniciar, mais veloz -> Abra o regedit e localize a chave: HKEY CURRENT_ USER\
CONTROLPANEL\DESKTOP, ¢ adicione o valor de seqiiéncia(string) com o nome de
MenuShowDelay ¢ seu valor 1.

o Programas carregados pelo sistema -> Abra o regedit e localize a chave
HKEY_LOCAL_MACHINE\ SOFTWARE\ MICROSOFT\ WINDOWS\ CURRENTVERSION\ e
verifeque as seguintes chave Run, RunOnce, RunOnceEx, RunServices, RunServicesOnce.

o Nome longo no prompt do DOS com mais de 8 caractéres (~1) -> Abra o regedit e localize a chave:
HKEY LOCAL_MACHINE\ SYSTEM\ CURRENTCONTROLSET\ CONTROL\ FILESYSTEM, com o
botdo direito, adicione novo valor binario com o nome de NameNumericTail com valor de 0.

. Autocompletar comando no modo DOS
HKEY_CURRENT_USER\SOFTWARE\MICROSOFT\COMMAND PROCESSOR, agora na janela da
direita encontre a chave DWORD chamada CompletionChar se fi existir, crie-a, € no valor coloque 9 este ¢ o n°
correspondente a tecla TAB.

° Servidor Telnet -> Painel de controle, ferramentas administrativas, Administracdo do servidor Telnet

1° Selecione o item 3 (Display/Change Registry Session). 2° No novo menu que aparece, escolha a opgao

7 (NTLM). O valor padrdo desta opcao ¢ 2, responda sim Y e desabilite 0 NTLM com a op¢do 0. Confirme a
mudanca com a Y novamente.Para sair deste menu pressione 0. Depois das alteragoes feitas, 5 p/ parar o servigo e
4 para iniciar, p/ que fagam efeito as alteragdes.

. Esconda os computadores do Ambiente de Rede -> recurso ttil p/ evitar que intrusos que gostam de

bisbilhotar, ja que vc continuara tendo acesso normal a todos os recursos de rede. Regedit
HKEY_CURRENT_USER\SOFTWARE\MICROSOFT\WINDOWS\CURRENTVERSION\
POLICIESWWNETWORK

. Localizacao dos aquivos com as mensagens do Outlook -> C:\Document and Settings\ sua pasta\
Local Settings\ Application Data\ {identidade}\ Microsoft\ Outlook Express



. Desabilitar a opcao de SHUTDOWN que permite que qualquer usuario desligue a maquina
HKEY_LOCAL_MACHINE\SOFTWARE\ MICROSOFT\WINDOWS\CURRENTVERSION\
POLICIES\ SYSTEM. ShutdownWithout Logon altere o valor para 0.

. Para compartilhar pastas que ficam invisiveis na rede p/ outros usuarios, basta por um $ apds o nome
do compartilhamento. Uma pasta chamada documentos com o nome de compartilhamento \\documentos$,
ficara invisivel para outros usuarios na rede, mantendo sua forma normal de acesso.

. Remover recursos de compartilhamento de rede invisiveis criados automaticamente.

HKEY_ LOCAL_MACHINE\ SYSTEM\ CURRENTCONTROLSET\ SERVICES\ LANMANSERVER\
PARAMETERS\ botdo direito REG_ DWORD e no value AutoShareServer p/ o sistema instalado for
Windows2k Server e AutoShareWks se for Windows2k pro. Clique em OK e na Data digite 0. reboot

. Desabilitar o AutoPlay no Windows2K -> Meu Computador, ferramentas, Op¢des da pasta, Tipos de
arquivos. Em Tipos de arquivos registrados, clique em AudioCD e Trilha de Audio de CD e clique em
play, se estiver em negrito e remover, sim.

o Para restaurar a ultima cépia do registro do Windows2K, reinicie a maquina, qdo aparecer a op¢ao de
selecionar o sistema, pressione F8 e selecione a ultima opgao e pressione Enter.

o Para manter a tecla Num Lock ativada: regedit ou regedt32 HKEY_CURRENT_USER\CONTROL
PANEL\ KEYBOARD, dé¢ um duplo clique em InitialKeyboard Indicators ¢ troque p/ 2.

o Fazer o Windows2K realizar um logon automaticamente: Abra o regedit e localize a chave
HKEY_LOCAL_MACHINE\SOFTWARE\ MICROSOFT\ WINDOWSNT\ CURRENTVERSION\
WINLOGON dé um duplo clique na entrada DefaultUserName(ex. Admin)e digite seu nome de usuario e
OK. Em seguida no valor de seqiiéncia (string) DefaultPassword(ex.:senha) € digite sua senha, fi existindo o
valor crie-0. Caso exista um dominio ou nome de grupo DefaultDomainName(ex..HOMELAN). Digite
AutoAdminLogon e 1 p/ ativar e 0 p/ desabilitar.

° Para criar o disco de restauracio de sistema, Iniciar, Programas, Acessorios, Ferramentas de Sistema,
Backup, clique no botdo “Disco de reparacdao de emergéncia”, ative a opgao que permite armazenar as
informagdes do registro e OK.

. Acesso rapido aos computadores de rede -> Abra o regedit e localize a chave:
HKEY_LOCAL_MACHINE\SOFTWARE\MICROSOFT\WINDOWS\CURRENTVERSION\
EXPLORER\REMOTECOMPUTER\NAMESPACE. Apague a seguinte chave:
{D6277990-4C6A-11CF8D87-00AA0060F5BF} reboot

. Aumentando a taxa de refresh o sistema sempre fard uma atualizacao na janela sempre que uma

alteragdo no drive o diretério for feita evitando assim pressionar o F5. Abra o regedit e localize a chave:
HKEY_LOCAL_MACHINE\SYTEM\CURRENTCONTROLSET\CONTROL\UPDATE na janela da
direita clique com o botdo direito em Update, modifique o valor de 01 p/ 00. reboot

o Desativar e Ativar o Dr. Watson -> Caso vc ndo queira transformar seu PC num cagador de bug’s

Abra o regedit e localize a chave: HKEY_LOCAL_MACHINE\SOFTWARE\MICROSOFT\WINDOWS
NT\CURRENTVERSION\AeDebug. Exclua a chave AeDebug no WindowsNT. E para ativar o software digite
a seguinte linha de comando drwtsn32 —i .



o Evite Travamento das janelas do Explorer rodando cada janela como um processo separado.

Abra o regedit e localize a chave: HKEY_CURRENT_USER\SOFTWARE\MICROSOFT\WINDOWS\
CURRENTVERSION\EXPLORER, crie novo valor DWORD nomeando-o DesktopProcess com n° 1. Logoff e
Logon.

o DisableExecutivePaging, mesmo que vocé 512 de RAM, o windows continuara usando o arquivo de
swap pagefile.sys. Abra o regedit e localize a chave:
HKEY_LOCAL_MACHINE\SYSTEM\CURRENT ->

CONTROLSET\CONTROL\SESSIONMANANGER\MEMORYMENAGEMENT, na chave

DisableExecutivePaging, mude o valor de 0 para 1. Opgao valida apenas para micros com mais de 128MB

. LargeSystemCache, ao contrario da opcao anterior habilitar esta funcao traz beneficios para quem tem
pouca RAM abaixo dos 64MB de RAM. Regedit: HKEY_LOCAL_MACHINE\SYSTEM\CURRENT-
> CONTROLSET\CONTROL\SESSIONMANANGER\MEMORYMENAGEMENT, na chave
LargeSystemCache. Mude o valor de 0 para 1.

. Desinstalando programas default do sistema, localize o arquivo sysoc.inf e retire todas as palavras hide,
que nele contiver. Reboot e logo depois os programas aparecerdo no Adicionar ¢ Remover Programas d o
Painel de Controle.

. Livre-se do Windows Messenger no XP

Feche o Messenger (clique com o botdo direito sobre o icone). - Clique em Iniciar — Executar - Copie e cole a
expressdo abaixo na janela de execucao

RunDI132 advpack.dll,LaunchINFSection %windir%\INF\msmsgs.inf, BLC.Remove ou

. Animacao das Janelas, a0 maximizar ou minimizar uma janela, vocé pode observar uma pequena
animagao. Para eliminar este efeito. Regedit
HKEY_CURRENT_USER\CONTROLPANEL\DESKTOP\ WINDOWSMETRICS. Com o botao
direito escolha valor de binario MinAnimate com o valor 0.

o Desabilitando o botao de Troca de Senhas, qualquer usudrio bastando prescionar ctrl+alt+Del e depois
Change Password pode realizar a troca de senhas. Para desabiltar abra o regedit:
HKEY_CURRENT_USER\
SOFTWARE\MICROSOFT\WINDOWS\CURRENTVERSION\POLICIES\ SYSTEM. Crie a chave
DWORD chamada DisableChangePassword com o valor 1 para desabilitar e 0 para ativar.

o Habilite o tamanho minimo de senhas HKEY LOCAL_MACHINE\ SOFTWARE\MICROSOFT\
WINDOWS\CURRENTVERSION\POLICIES\NETWORK, crie uma nova chave binaria(binary) com
o nome MinPwdLen, para validar esta chave atribua o valor decimal para o tamanho da senha minima.
Vocé pode habiltar a op¢ao que for¢a o tamanho minimo da senha obrigando que o usudrio sempre utilize
pelo menos o n° de caracteres habilitado.

o Alterando o Nome na Barra do Internet Explorer, regedit no painel esquerdo do editor de registro abra
as chaves até encontrar:

HKEY_USERS \DEFAULT\SOFTWARE\MICROSOFT\INTERNET EXPLORE\MAIN. No painel direito

selecione a sub-chave Window Title (ou crie essa chave) D& um duplo clique nessa chave e altere-a conforme a

sua necessidade; por exemplo: "::SuperDICAS::" (sem as aspas)



. No windows xp quando abre o Meu computador para procurar pastas , o Xp automaticamente
procura por ficheiros de rede e impressoras. Isto pode causar uma certa demora na abertura de
icones.Mas pode melhorar a velocidade através destes passos: Start > Open My Computer > Tools >
Folder Options > View > Agora tire o visto -Automatically search for network folders and printers >
Apply > Ok.

J A cada boot, 0 XP cria novos parimetros que sio guardados dentro do diretorio Perfetch, na sua
pasta Windows. Acontece que a presenca de parametros antigos nesta pasta compromete
assustadoramente o desempenho do boot (lembram do utdpico boot de 1 barrinha durante o BootVis?) e
o site sugere a exclusdo destes arquivos que cairam em desuso.

1. Va no Bloco de Notas.

2. Digite "del c:\windows\prefetch\ntosboot-*.* /q" (sem as aspas, evidentemente)

3. Salve este arquivo com o0 nome ntosboot.bat (o nome fica seu critério) na raiz.

4. Execute o gpedit.msc

5. Va em Configuragdes do Computador, e depois em Configuragdes do Windows. Do lado direito da tela clique

no item Scripts (Inicializagdo/Encerramento).

6. Clique duas vezes em Desligar.

7. Na janela que se abre clique em adicionar e depois procurar.

8. Encontre e selecione o arquivo que vocé criou 14 em cima, no caso o ntosboot.bat . Selecione-o e dé todos os

OKSs que tiver que dar.

. Um Fix Para o Win2K/XP Para os AMD Athlon

Se esta tendo problemas com os programas que ficam pendentes no seu sistema, e tem no seu sistema um
adaptador de video AGP e um processador da AMD Athlon, talvez percise de modificar ou adicionar uma coisa
no registo...

Coloque ou modifique no registo as seguintes informagoes:
HKEY_LOCAL_MACHINESYSTEM/CURRENTCONTROLSET/CONTROL/SESSION MANAGER
Value Name: LargePageMinimum, Data Type: REG_ DWORD, Value: OXFFFFFFFF in Hex / 4294967295 in
Decimal

o Apague o pagefile no shutdown NT4S/NT4W

Apagando o arquivo pagefile.sys quando o WinNT for desligar evita que o mesmo fique fragmentado (embora o
shutdown seja mais demorado):

regedit.exe e vi em HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Session
Manager\Memory Management

D& um duplo clique em ClearPageFileAtShutdown e altere o valor da varidvel para 1 (um).

Feche o regedit e restarte 0 WinX

o Para vocé habilitar o ClearType va em Painel de Controle (Control Panel) > Display (Video) >
Aparéncia (Appearance) > Efeitos (Effects) e clique no segundo quadrado, escolhendo a opgao ClearType

o Sem o0 Menu Documentos -> regedit ->
[HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer], no
painel da direita Novo, Valor Binario NoRecentDocsHistory - 01 00 00 00 e NoRecentDocsMenu - 01
00 00 00.

. Eliminando os "baldes de aviso'" do WinXP

regedit -> va em HKEY CURRENT _ USER \Software \Microsoft \Windows \CurrentVersion \Explorer
\Advanced -> clique no menu Editar -> Novo -> Valor DWORD -> digite EnableBaloonTips e tecle enter.
Se ja houver essa variavel ali, altere o seu valor para 0 (zero) ...



o J& ouvi falar de muitas pessoas reclamarem sobre terem velocidades baixas no windows w2k/xp mas no
windows 95/98 serem rapidas ! Esté dica aplica-se apenas para coxexdes Lan ( local area network )
Copia as linhas e guarde-as ( Bloco de notas ) como Qualquercoisa.reg nao Qualquercoisa.txt
Depois da duplo clique para aplicares e renicia o pc

Windows Registry Editor Version 5.00

"SizReqBuf"'=dword:0000fftf

. O seu WinXP nio desliga corretamente

va em Painel de Controle (Control Panel) > System (Sistema) > Hardware > Gerenciador de Dispositivos (Device
Manager) > duplo-clique em Computador (Computer) e veja se ele esta configurado como "Interface de energia e
configura¢do avangada (ACPI) PC (Advanced Configuration and Power Interface (ACPI) PC)" ou Computador
Padrdo (Standard PC). Se ele estiver configurado como Computador Padrdo, restarte 0 WinXP, entre na BIOS do
micro e habilite 0 APM (Advanced Power Management).

. Desabilite a Reinicializa¢do automatica do WinXP, pois se estiver ocorrendo um erro durante o
shutdown, o micro rebootara: va em Painel de Controle (Control Panel ) > Sistema (System) > Avancado
(Advanced) > botao Cinfiguragdes em Inicializa¢do e Recuperagdo (Startup and Recovery) > desclique a
opgao

Reiniciar automaticamente (automatically Restart) na area Falha do Sistema (System Failure) ...

o Desabilite 0 ACPI na BIOS do seu micro, pois se 0 ACPI da sua BIOS tiver um bug ou ndo seguir 100%
o padrdo estabelecido, 0 WinXP ¢ afetado por isso ...

o Para micros ATX, verifique o NT Apm/Legacy Interface Node indo em Painel de Controle (Control
Panel) > System (Sistema) > Hardware > Gerenciador de Dispositivos (Device Manager) > menu Exibir
(Show) > Mostrar dispositivos ocultos (Show hidden devices). Se aparecer a opcao NT Apm/Legacy
Interface Node, dé um duplo-clique nela e habilite-a. Se essa op¢ao ndo aparecer, ignore essa dica ...

. Como fazer com que o Explore mostre os atributos dos arquivos no modo de visualizacido Detalhes
Cadé a coluna Atributos ? Até o Win 98, ela estava la. E ndo adianta ir em Exibir/Opc¢des de Pasta/Modo
de Exibicdo. Também ndo estd 14 a opcdo Mostrar Atributos de Arquivos no Modo exibi¢do de
Detalhes. Execute o regedit e va até a pasta:

HKEY_ CURRENT_ USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced

No painel da direita dé um duplo clique em ShowAttribCol. Abre-se uma pequena janela. Na caixa Dados de

Valor, no lugar do 0 escreva 1, e clique em OK. Abra o Explorer. A coluna Atributos voltou a aparecer.

o A tela de logon do XP nao permite que escolha o usuario Administrador, para corrigir; regedit,
HKEY_CURRENT_USER\.DEFAULT\ SOFTWARE\ MICROSOFT\ WINDOWS\
CURRENTVERSION\ ThemeManager. Localize o valor ThemeActive e altere este valor para 0
ou 1. Mescle os dois arquivos .reg aqui contidos

. Desabilite programas desnecessarios da inicializacio indo em Iniciar > Executar, digite msconfig (sem
aspas). Na aba Iniciar, desabilite os programas que ndo quer que iniciem junto com o Windows.

. Abrindo o Windows Explorer com o0 Meu Computador expandido; nas propriedades do atalho, na guia
atalho em Destino alterar para %SystemRoot%\explorer.exe /e, /n, ,:: {20D04FE0-3AEA-1069-A2D8-08002B30309D} "
com as aspas.



o Apague as Pastas Especiais do ""Meus Documentos': em iniciar -> executar RegDone

. Como acessar 0 Windows Update sem precisar fazer seu Registro On-line

O acesso ao recurso de atualiza¢do on-line — Windows Update, completamente desativado até que o usuario
complete o processo de Registro OnLine. Para destravar esta protecao, € preciso fazer a seguinte alteracdo no
registro no Windows: Execute o Regedit e va até a pasta:

[HKEY LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion|

Localize a chave RegDone, e faca a seguinte alteracdo: 1

. O WinXP tem chksdsk e defrag .... ?
Sim, ele tem versdes especificas do chkdsk e defrag: assim que o usuério acessa o chkdsk via botao
Iniciar (Start) > Meu Computador (My Computer) > clique com o botao da direita do mouse no Drive C >
Propriedades (Properties) > Ferramentas (Tools) > Verificar agora (Check Now) > clique nas duas opgdes
e no botdo Iniciar (Start), uma verificagdo ¢ programada para ser realizada antes do login do WinXP no
préximo boot. O Defrag ¢ realizado instantaneamente e pode ser acessado via Iniciar (Start) > Meu
Computador (My Computer) > clique com o botdo da direita do mouse no Drive C > Propriedades
(Properties) > Ferramentas (Tools) > Desfragmentar agora (Defrag Now) > botdo Desfragmentar
(Defrag)...

. Impedir que 0 Windows Messenger inicie junto com o Windows:
Iniciar > Executar > gpedit.msc. Na janela que abrira, vd em Configuracdo do Computador > Modelos
Administrativos > Componentes do Windows > Windows Messenger. Clique duas vezes na op¢ao “Nao
permitir que o Windows Messenger inicie automaticamente”, e selecione “Ativado”.Se preferir, pode
desativar de vez o Windows Messenger, alterando a opgao “Nao permitir que o Windows Messenger seja
executado” para “Ativado”. Isto impedira a utilizagdo do WM por qualquer usuario do micro.

« Download do Internet Explorer 6SP1 para todos os sistemas
baixem o instalador do Internet Explorer para o idioma do seu sistema operacional neste endereco:
http://www.microsoft.com/windows/ie/downloads/critical/ie6sp 1/download.asp
Salvem o arquivo no seu drive C:\
Agora executem o seguinte comando:
iebsetup.exe /c:" iebwzd /D:1"

+ Desligar Bem + Rapido

Chave HKEY CURRENT USER\Control Panel\Desktop\ -> encontre o valor HungAppTimeout que deve estar
em 5000 (padrdo). Se ndo estiver, coloque. Por ai mesmo, procure o valor WaitToKillAppTimeout. Troque o valor
para 4000 (Embora a sugestio do colega TheBest seja trocar para 100). Depois, em

HKEY LOCAL MACHINE\System\CurrentControlSet\Control\ e troque o valor de WaitToKillServiceTimeout
para 1000. E em Ferramentas Administrativas no Painel de Controle, clique em Servigos e procure o servigo
NVidia Driver Help. Em suas propriedades, marque-o como Manual e ndo como Desativado. Pra finalizar execute
o arquivo gpedit.msc Va at¢ Modelos Administrativos, pule para Sistema e depois Perfis de Usuario. Do lado
direito da tela aparece a opgao Numero maximo de tentativas para descarregar e atualizar perfil de usuario. Ative-
o ¢ atribue o valor 0. O XP, ¢ problematico para lidar com Cache L2. Se vocé souber exatamente o quanto de
Cache L2 seu processador tem, va em

HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory Management\
Procure pelo valor SecondLevelDataCache. Dé um duplo clique. Na janela que se abre marque a bolinha
"Decimal" e em "Value Data" digite quantos kilobytes de Cache L2 o seu processador tem.

E por fim; nenhum windows, por mais estavel que seja, libera toda a memoria que era ocupada por um aplicativo
quando ele ¢ fechado. Sempre fica uma DLL esquecida na memoria, o que torna praticamente impossivel ndo ter
que reiniciar o computador para o micro ficar mais leve apds uma sessao mais hardcore de Office, por exemplo.



e Para obrigar o WindowsXP a descarregar da meméria todas as DLLs que ndo estdo em uso, vd em
HKEY LOCAL MACHINE\SOFTWAREMicrosoft\Windows\CurrentVersion\Explorer
Chegando 14, vocé vai ter que criar uma nova chave chamada AlwaysUnloadDLL. Clique com o botdo direito do
mouse na chave Explorer, aponte para Novo, depois Chave. Uma nova chave vai ser criada dentro do item
Explorer (vai parecer uma pasta nova). Renomeie-a para AlwaysUnloadDLL e troque o valor Padrao para 1 invés
de 0.
e Para Otimizac¢ao oculta do boot default do win
HKEY LOCAL MACHINE\SOFTWAREWMicrosoft\Dfrg\BootOptimizeFunction\ na chave a esquerda
(Valordesequéncia) OptimizeComplete como Y e o Enable tb como Y

SERVICOS

- AUTOMATICO

Alerta (emite alertas administrativos)

Alocador Remote Procedure Call (RPC)

Armazenamento protegido (favorece a seguranca do computador)

Audio do Windows (possibilita a ativagio de dispositivos de dudio.)
Chamada de procedimento remoto (RPC)

Cliente da Web (necessario para algumas situagdes, como o Windows Update)
Cliente de rastreamento de link distribuido

Deteccao do hardware do Shell

Estacio de trabalho (gerencia conexdes com servidores remotos)
Gerenciador de contas de seguranca (Responsavel por armazenar senhas locais)
Gerenciador de discos légicos (Gerencia unidades de disco rigido)
Localizador de computadores

Log de eventos

Logon secundario

Notificacio de eventos de sistema

Plug and Play

Servico de restauracio do sistema (se ndo usa ou ndo sabe o que €, pode deixar em Manual)
Servicos de criptografia

Servicos IPSEC

Sistema de eventos COM+

Spooler de impressao

Temas

Testador de instrumentaciio de gerenciam. do Windows

- DESABILITADOS

Acesso a dispositivo de interface humana (usado para dispositivos especiais de entrada)
Ajuda do cartio inteligente (Ajuda para dispositivos Smart Cards)

Cartao inteligente (ativa dispositivos de Smart Card)

Compartilhamento remoto da area de trabalho do NetMeeting

Configuracao zero sem fio (necessario para dispositivos 802.11)

Gerenciador de conexio de acesso remoto automatico

Gerenciador de sessdo de ajuda de area de trabalho remota

Horario do Windows (Mantém data e hora em sincronia com servidores de rede)
IMAPI CD-Burning COM Service Ativa o recurso de gravacdo de CDs embutido do Windows XP)? Se vc grava CDs
usando apenas os recursos do Windows XP, deixe em Manual (padrio)

Numero de série de midia portatil

Registro Remoto (por questio de seguranca - permite que usudrios remotos alterem o Registro do seu Windows)
Roteamento e acesso remoto



Sistema de alimentacio ininterrupta (Gerencia No-Breaks) (Se vocé usa um no-break, deixe em Automatico)
Telnet (por questdo de seguranca) <- Talvez

MANUAL
Adaptador de desempenho WMI

Agendador de tarefas (Agenda tarefas para serem executadas em data e hora pré-determinadas) t

Ajuda e suporte (Ativa assistentes ¢ ajuda avancada) t
Aplicativo de sistema COM+
Area de armazenamento (Compartilha informagdes com computadores remotos)

Armazenamento removivel (Dispositivos de armazenamento removiveis, como Zip Drives)

Assistente de aquisicio de imagens do Windows (WIA)
Atualizacdes automaticas (faz o download automaticamente de atualizagdes do Windows)
Auxiliar NetBIOS TCP/IP

Carregar Gerenciador (gerencia transferéncias de arquivos entre computadores da rede.)

Cliente DHCP (necessario para alguns tipos de conexao a Internet)
Cliente DNS (necessario para alguns tipos de conexdo a Internet)
Compatibilidade com 'Troca rapida de usuario’

Conexdes de rede (gerencia conexdes de rede)

Coordenador de transacgodes distribuidas (Coordena gerenciadores de recursos)
Cépia de volume em meméria
DDE de rede (Habilita o Dynamic Data Storage)

DSDM de DDE de rede (Gerencia compartilhamentos de rede DDE)

Erro ao informar o servico (Informa erros de servigos ¢ aplicativos de terceiros)
Extensdes de driver de instrum. gerenc. do Windows (Gerenciamento de drivers)
Firewall de conexido com a Internet (FCI) / Compartilhamento de conexdo com a Internet (CCI)

Fornecedor de suporte de seguranca NT LM

Gerenciador de conexio de acesso remoto
Gerenciamento de aplicativo
Host de dispositivo Plug and Play universal

Logon de rede

Logs e alertas de desempenho o
Mensageiro (Servico de mensagens entre computadores da rede. NAO E o Windows Messenger)
MS Software Shadow Copy Provider

Numero de série de midia portatil

QoS RSVP (Habilita services compativeis com o QoS)
Reconhecimento de local da rede (NLA)
Servico administrativo do gerenciador de disco logico

Servico de descoberta SSDP

Servico de indexacao
Servico de transferéncia inteligente de plano de fundo
Servico 'Gateway de camada de aplicativo'

Servicos de terminal

Servidor
Telefonia
Windows Installer
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